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About TP414 -- Sample Planner for Variables

What does TP414 do?
TP414 calculates the sample size (n) and acceptance/rejection limits for sampling plans for variables 
data. The sampling requirement can be expressed in terms of either a mean or a fraction non-
conforming to ISLs. The user specifies the sampling requirement by entering a Consumer's Point and a 
Producer's Point of the desired oc curve. TP414 also will analyze an existing fixed-n decision rule and 
can convert it to a matched sequential plan. 

Decision Rules:
TP414 performs the calculations for fixed-n and sequential decision rules.

Performance Curves:
TP414 evaluates the performance of Fixed-n and Sequential sampling plans with performance curves: 
OC, ASN, ARL, AOQ, and AFI curves.

Example of Input:
Names that specify the project, process, and lot definition and disposition.
OC curve points like Alpha= 0.05, Beta= 0.05, AQL= 0.01, RQL= 0.91.
OC curve points like Alpha= 0.05, Beta= 0.05, AQLML= 2.0, RQLML= 5.0.
     (OC curve points can be input or output.)
Fixed-n decision rule like: n=98, AL=3, AU=4
     (The decision rule can be input or output.)
Sample results to evaluate with confidence limits, like: n=98, Xbar=4.

Examples of types of output reports:
Performance curve tables containing OC, ASN, ARL, AOQ, and AFI curves.
Performance graphs of OC, ARL, ASN, AOQ, and AFI curves.
Fixed-n decision rule report.
Sequential decision rule table.
Sequential decision rule graph.
Confidence limit report (one-sided and two-sided limits).

Quick Start
For the latest information about the most recent version, see the ReadMe.txt file that was distributed with TP414 
V3

How to Install TP414 v3:
Save the Zip file. Extract the .EXE file from the Zip file. Double click the .EXE in Windows Explorer to start the 
install wizard. Follow the instructions.

How to manage your license:
Your license's current status is shown in the [Help] [About] menu. The license might be pre-activated, depending 
on how you purchased the product. If the [Design] menu does not open then you may need to activate a license 
that you can obtain from H & H Servicco Corp. 

How to Uninstall TP414 v3:
Click [Start][Settings][Control Panel][Add/Remove Programs] Uninstall TP414 3.0

How to Use TP414 v3 -- 8 usage tips:

Design a sampling plan
1) Start TP414. To start designing a sampling plan, select [Design] from the main menu, followed by either 
[Fraction nonconforming to ISL] or [Mean with Lower or Upper or Both RQLs].
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Select for example: "Fraction nonconforming to ISL"

A window will open with six Tabs across the top. Select Tab "2=Design Plan". You will see that the program has 
automatically added default input data -- for you to modify in order to design your own sampling plans.

Replace the default AQL, RQL, Alpha, and Beta with your consumer's and producer's points (AQL, RQL, Alpha, 
Beta) or replace the fixed-n decision rule with your own decision rule (n, k).  Use all decimal fractions for AQL, 
RQL, Alpha, and Beta -- not percentages. Push the appropriate "Calculate" button.

Generate performance reports:
2) Make reports of the sampling plan performance curves (OC, ASN, AOQ, ARL, AFI curves) from tab 3 and tab 
4. 

Generate fixed-n and sequential decision rules:
3) Make reports of the sampling plan decision-rules from tab 5. (Fixed-n or Sequential decision rules)

Generate a confidence limit report for a lot or process:
4) Enter values for sample data into tab 6 to make a confidence limit report. For ISL plans add the specification 
limits LISL, UISL, or both. Choose one-sided or two-sided confidence limits. 

Handling multiple reports on the screen
5) When you have multiple reports on screen, you can arrange them for easy examination: 
[Window][Arrange]. 
(For simplicity, the right mouse button over a report will invoke the Window menu.)
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6) Toggle any individual report between full size and normal size by double clicking on it.

7) For easier viewing, increase the viewing area to full screen by maximizing the overall program to full screen. 
(Use/click the upper right  "full screen" symbol on the title bar)

8) Check the website for notice of updates, bug fixes etc.

How to get help or to inform us of problems or bugs:
Email -- service@samplingplans.com
Telephone -- 651-777-0152
Website -- www.samplingplans.com
Interactive discussion forum: www.samplingplans.com/forum2

Menu Bar

TP414  menu bar ..

The File menu will print a copy of the report that has the focus to the default printer, copy it to the Windows 
clipboard, or exit the program.

The edit menu will modify reports.

Cut will remove the selected area and store it on the Windows clipboard for further processing with other 
software such as word processors.

Copy will copy the selected area to the Windows clipboard but will not remove it from the report.

Copy Columns:  Use this option to transfer data to other software to make graphs/charts. It will copy selected 
columns of data from performance tables and sequential decision tables to the Windows clipboard.  

For further details, see the instructions on making use of the Excel chart wizard for performance graphs and 
sequential decision graphs.

Delete will delete (remove) one or more report.
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The View menu controls the menu bar and the status bar.

The Design menu is the main starting point to design a sampling plan. There are two ways to specify a sampling 
requirement -- as the fraction of items nonconforming or as the mean of the variable.

The Window menu controls the windows on the interface. 
The "Show" option will display reports if they are hidden under the design form window.

The "Close" option removes all reports from the screen, or will remove the design form.

The Right mouse button pop-up menu is the same as the Window menu. You can right click over any sampling 
plan report window or over the design window.

The Help menu provides help in using TP414.
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How to use TP414

Tab1 -- Application Description

The screen-shot below shows that the planning window contains six tabs across the top. Each tab gives you access to one 
aspect of the planning process. You can develop a sampling plan by selecting the tabs in sequence: 1,2,3,4,5,6

The "Application" tab is currently shown. 

On the "Application" tab you can identify the sampling plan that you are developing by naming the company, 
product, item, and characteristic. This information does not have any effect on the decision rules that you will 
make the program calculate, but it will be used to make the reports more meaningful.

You also can define what a lot is and specify what is to be done with a lot when it is accepted and when it is 
rejected.

The program will add default data to the "Application" tab at startup, so you have the option to skip Tab1 until 
you finish designing the sampling plan and are ready to refine the documentation for printing.
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Tab2 -- Design a Sampling Plan

The "Design Plan" tab is where you design the sampling plan.  This is where you relate the producer's point, the 
consumer's point, and the fixed-n decision rule.

Sampling Plan Calculation Steps:
• Enter the within-lot or short term SD. If SD is not known in advance it will have to be calculated from the 

sample.

• Enter the Individual Specification Limit(s) -- ISLs

Depending on what information you start with, you can perform three types of calculation with the "Design Plan" 
tab:

• You specify the two-points on the oc curve: AQL, Alpha, RQL and Beta. 
Then calculate the decision rule: [Calculate  n and k] 

• You specify the fixed-n decision rule (n, k) and the AQL & RQL. 
Then calculate the risks:  [Calculate Alpha and Beta risks] 

• You specify the fixed-n decision rule (n, k) and the Alpha & Beta risks.
Then calculate AQL & RQL:  [Calculate AQL and RQL]

Additional information displayed:
For plans with SD known:

• Cpk is displayed.
• Cp is displayed for plans with both lower and upper ISLs
• Accept/reject limits for Xbar are optionally shown (controlled by a checkbox.)
• The sampling plan designed on tab 2 is automatically transferred and displayed at the top of tabs 3, 

tab4, and tab 5. 
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Tab3 -- Make Tables of Performance Curves

Tab 3 "Performance Tables" makes tables of OC, AOQ, ASN, AFI, and ARL performance curves for the 
sampling plan that you designed on Tab2. 
 

The sampling plan designed on Tab2 is displayed at the top of Tab3. 

Check the performance curves that you want to be in the table.  In addition to the OC curve, you may include the 
AOQ, ASN, AFI, AND ARL curves.

The report containing the calculated table is shown on a later page: example of the performance curve report.

Curves that require additional information or restrictions:
The AOQ curve reflects the results of rectification when you check "Rectify Rejected Lots".  For non-rectification 
plans the AOQ table will show that AOQ=p' fraction nonconforming for all values p'.

The AFI curve requires that you specify a finite lot size. The lot is the population, (N), from which the sample is to 
be drawn. For a continuous process, enter the number of items corresponding to a sample period.

Effects of decision rule type on the performance curves:
The sequential / fixed-n choice effects the ASN and AFI curves, but not the OC, ARL, or AOQ curve.
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Tab4 -- Make Graphs of Performance Curves

The "Performance Graph" tab (Tab4) is where you make graphs of the performance curves.

The sampling plan designed on Tab2 is displayed at the top of Tab4. 

Select a type of graph.
Choose one curve type at a time: OC, AOQ, ASN, AFI, or ARL.
Select whether the decision rule is sequential or fixed-n.

This effects ASN, AFI, not OC, AOQ, ARL.
Choose whether rejected lots are to be rectified:

This effects AOQ, AFI, not OC, ASN.
Enter the lot size:

This effects AOQ, AFI, not OC, ASN, ARL.

NOTE: With the options SD=unknown and both LISL and UISL specified, performance curves cannot be 
calculated. In that case, use the curves for LISL and UISL separately.

Specify the limits of the Xaxis and Y-axis.
Maximum Y-axis: Pa for OC, AOQ, AFI, ASN, or AFI.
Minimum and maximum: p' or mean.
Step size of p' or mean along the Xaxis.

Recommended: for most cases, the program default limits scale the graph well.
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Tab5 -- Make Decision Rule Reports

This "Decision Rule" tab is where you make the decision rule reports. The fixed-n and sequential plans have matched oc 
curves -- that is, both have the same producer's and consumer's points.

The sampling plan designed on Tab2 is displayed at the top of Tab4. 

Make 3 kinds of decision rule report: 
1) Display a Fixed-n sampling plan. 
The fixed-n decision rule consists of a sample size, n, and acceptance number(s) for k or for the sample average.

Include Extra Statistical Details: You can include the slope, intercepts, and other properties of the SPR sequential 
sampling plan that matches the oc curve of the fixed-n plan   

Define sequential plan:
TSS Vs SPR: 
TSS plans are adjusted to maximum sample size = Fixed-n. (Recommended)
SPR plans require user to specify a truncation rule. TP414 offers three ways to truncate a plan.

• Truncate n at 3 times the maximum of the average sample number (ASN) curve.
• Truncate n at 1.2 times fixed-n
• Manually enter the truncation n.

2) Display a sequential decision rule as a table of numbers. 

3) Display a sequential decision rule as a graph: 
The program calculates the maximum Y-axis (sample average) and Xaxis (sample number), but you can change 
them manually
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Tab6 -- Make a Confidence Limit Analysis

Tab6 is where you analyze a sample result to make a confidence statement.

Input fields:
• Enter the sample data: n, Xbar, and SD.
• Enter UISL, LISL, or Both. (For Both, see NOTE below.)
• Choose the percent confidence.
• Choose the type of confidence limit(s): one sided (upper or lower) or two sided.

Confidence limits are calculated:
• CL of lot fraction nonconforming for ISL plans 
• The lot mean shown is the mean corresponding to that FD.
• The number of nonconforming items in the lot corresponds to that FD.

Two ISLs restrict the lower CL of p':
With two ISLs, the minimum fraction nonconforming (p') occurs when the mean is positioned halfway 
between them. The p' is minimum at that point. When the confidence interval for the mean includes the 
specification midpoint, then the lower CL of p' -- being the lowest p'  in that interval -- occurs at the midpoint. 
In this case, the table shows the mean at the midpoint -- rather than the CL of the mean. In all cases, the 
mean shown is the mean that corresponds to the value of p

Symbols with two ISLs. (Both LISL & UISL):
The following symbols indicate whether the mean differs significantly from that mid-specification target.

• (T) Mean is not significantly different from target (midpoint of ISLs.)
• (H) The mean is significantly above target. (The lower CL of the mean is above the midpoint between the 

ISLs)
• (L) The mean is significantly lower than target. (The upper CL of the mean is below the mid-spec)
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Producing Output Reports

Report3a -- Table of Performance Curves
The "Performance Table" report shows five performance characteristics:  OC, AOQ, AFI, ASN, ARL, 
and how they relate to:
The lot/process fraction nonconforming to ISL(s).
The probability of acceptance.
The lot/process mean -- available for known SD plans only.

The stepping variable always appears as the leftmost column -- in this case the mean.
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The AOQL can be observed as the maximum of the AOQ curve. In this case, AOQL=0.02531 fraction defective.

Below the curves is an explanation of the assumptions and relationships that are affecting the performance 
characteristic curves. 

The footer of the report displays the program version and run date.

Report4a -- Graphs of performance curves

Tab4 enables you to view, print, or save text graphs of the OC, AOQ, ASN, ARL, AFI curves.

Here is more information about how this graph was made: graphs of performance curves.
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You can make a better-looking graph by selecting the rows of a performance table that contains p', Pa, etc. 
columns. Then [Edit][Copy columns] to the Windows clipboard and paste them in to a graphic program. Most 
spreadsheet programs do can make graphs, like MS Excel, or the spreadsheet in Open Office, etc. Their Chart 
wizards enable you to tailor-make graphs:

Report4b -- Performance Graphs with the Excel Chart Wizard

If you have Microsoft Excel or equivalent, you can copy a performance table into an Excel spreadsheet and use 
Excel's chart wizard to make a graph containing one or more curves.

See the step by step details:
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Report4c -- Performance Graphs with Excel - Step by Step

These steps will produce a performance curve graph using TP414 and the Excel chart wizard.

Produce the curve with TP414:

Make a performance table containing the desired columns.
Example: Use the program default sampling plan: n=98, c=4.  

On tab3 of TP414, select an OC curve, p' stepping, default Maximum p', Minimum p', and step size.

Make the table with TP414. (Not the graph.)

Transfer the table to Excel:

With the mouse cursor, select the rows of the table that contain curves in columns. 

On the TP414 menu select: [Edit][Copy Columns] 

In an empty Excel sheet, select the sheet by clicking on the square where the row headings and the column 
headings join.

On the Excel menu select: [edit][paste] or control-V

Create an OC graph with Chart Wizard:

Select the data.
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Example A1:B20

Select the chart wizard from the tool bar.

Step 1 of Chart Wizard:
Select: Chart Type: XY(Scatter) 
Select: Chart sub-type:
"Scatter with data point connected by smoothed Lines without markers"

Note: For sequential decision charts, you would use chart sub-type: "Scatter with data points connected by 
lines without markers."

[Next>]

Step 2 of Chart Wizard:
Option series in columns (default) [Next>]

Step 3 of Chart Wizard:
Chart Title Tab: 
Example: "OC-Curve for: n=98, C=4"

Value (X) axis: 
Example: True Lot Fraction Defective (p') 

Value (Y) axis: 
Example: Probability of Acceptance (Pa) 

Gridlines Tab
Example: Value (X) axis: check "Minor Gridlines"
Example: Value (Y) axis: check "Minor Gridlines"

Legend Tab
Uncheck "Show legend" (Unless you are plotting more than one curve."

[Next>]
Step 4 of Chart Wizard:
Place Chart
Example: "As object in sheet"

[Finish] View the chart. It should look pretty good.

Refinement - change the scale of the Pa axis of the chart:

The Pa axis is 0 to 1.2. Change it to 0 to 1.0.

Select the Pa axis.
Right-click, select "Format Axis", Scale Tab.
Change Maximum from 1.2 to 1.0.
Change Major unit from 0.2 to 0.1
Change Minor unit from 0.04 to 0.05

Refinement - change the scale of the p' axis of the chart:

The p' axis has increments of 0.02. Change them to 0.01.

Select the p' axis.
Right-click, select "Format Axis", Scale Tab.
Change Major unit from 0.02 to 0.01
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Change Minor unit from 0.004 to 0.005

Refinement - change the background color of the chart.

Select Plot Area, Right-click, Format Plot Area.
Example:
Border: Select "None"
Area color: select white.

Use the mouse to change the width and height of the chart to your liking. The chart should look like this.
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Report5a -- Fixed-n Decision Rule Report

This fixed-n decision rule report was made from the tab "5=Decision Rule".

The decision rule matches those of standards Mil-Std-105 and ANSI/ASQ Z1.4.

This report completely documents the sampling plan: the producer's point and the consumer's point, the fixed-n 
decision rule, the date that it was designed, and the software used and its version number. 
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Extra statistical details:
If you check "Include Extra Statistical Details" on tab "5=Decision Rule" the report would also display properties 
of the sequential plan whose oc curve matches this fixed-n plan. 

The slope and intercept of the lines of the sequential chart match with those in the standard ISO 8422.
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Report5b -- Tables of a Sequential Decision Rule

From the "5=Decision Rules" tab you have the option of TSS or SPR sequential decision rules. The two kinds of 
sequential are have matched oc-curves
 
TSS Decision Rule:

Each row of the table contains a sample number and the rejection and acceptance limits. Compare the sample 
average to the limits. If the comparison neither accepts nor rejects, increase the sample size, recalculate the 
sample average, and compare again. The final line of the TSS plan is the fixed-n sample size and fixed-n 
decision limit.
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SPR Decision Rule:

The SPR decision rule is implemented identically to the TSS decision rule. 
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Report5c -- Graph of Sequential Decision Rules

From the tab "5=Decision Rules" you can make graphs of sequential decision rules.

The sample number and decision limits of this SPR graph match the previous SPR table. The first column of the 
table is the X-axis of the graph. The lines representing the accept and reject limits correspond to the accept and 
reject columns of the table. 
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You can make a better-looking graph by selecting the rows of the table that contain just the columns of data. 
Then [Edit][Copy columns] to the Windows clipboard and paste them in to a graphic program. Most spreadsheet 
programs can make graphs, like MS Excel, or the spreadsheet in Open Office, etc. Their Chart wizards enable 
you to make good-looking graphs:
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Report5d -- Sequential Graphs with Chart Wizard

This sequential decision chart was made by exporting columns to Excel. Then using the Excel chart wizard.
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Report5e -- Sequential Graphs with Excel - Step by Step

You can transfer a decision rule table to Excel by cut/paste:

Select the table as above. Then [Edit][Copy]
Open Excel, Open Office, or other spreadsheet.

• Select the blank sheet by clicking the upper left square.
• The data will go into column 1 with [Edit][Paste]. 
• Delete the blank row: Select [Edit][Delete]
• Select the imported rows in column 1.
• Convert the data to columns: [Data][Text to Columns ...]
• Use the chart wizard to make the sequential plot. 

The plot above is made with options: XY(scatter), "Scatter plot with data connected by smoothed lines." 
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Report6 -- Analyze Sample Result -- confidence limit report
This report contains 5 sections:

(1) A summary of the product and its requirement.
(2) The Sample result:
(3) Interval estimates of fraction nonconforming, the mean, and the number nonconforming in the population.
(4) The statistical basis of the report.
(5) The date, program version, and 
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Additional Information

The Producer's and Consumer's Points.

The producer's and consumer's points on an oc curve are: 

Producer's point: (AQL, Alpha)
The producers point protects against rejecting good ( p'  =  AQL) lots.

Consumer's point: ( RQL, Beta)
The consumer's point protects against accepting off-grade ( p'  =  RQL) lots.

TP414 calculates from tab2 the fixed-n decision rule that has its oc curve going through those two points. 

TP414 calculates from tab3 and tab4 all the points on the OC Curve that goes through the producer's and 
consumer's points.  

TP414 calculates on tab5 the fixed-n report and the TSS and SPR sequential plans that go through the 
producer's and consumer's points.

Understanding the OC Curve

Using the OC Curve -- Plot of Pa versus p'
This oc curve describes the performance of a decision rule. For this example, the plan is an attribute plan and 
the decision rule is n=98, Ac=4.  The concept and method is the same for variables data where the X-axis is 
either the true mean or the true fraction nonconforming to ISL.

This example decision rule (n=98, Ac=4) was designed by specifying two points of the oc curve (four numbers) on 
the Design tab:

Producer's point: AQL=0.02, Alpha=0.05
Consumer's point: RQL=0.091, Beta=0.05

Every decision rule ( n , Ac )  has its own oc curve, which describes the sampling plan's probability of accepting 
lots having various fractions defective. 
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Possible Fractions Nonconforming

TP414 does not use lot size to relate AQL and RQL to n and AL or AU. So it can not automatically make AQL or 
RQL to any specific value of lot p'. For example, with lot containing N items, the possible fractions 
nonconforming are:
p':  0,  1/N,  2/N,  3/N ....  

Specifically,  if N=100, the possible numbers of defective items are:
defectives =   0, 1, 2, 3 ...

So the true values of p' are limited to:
p' =   0/N =  0.00,   1/N = 0.01,   2/N = 0.02,   3/N = 0.03 ...

Consequently, it is possible to specify AQL and RQL that cannot be attained exactly. 

How to account for the effect of Inspection Error

Inspection error is implemented for attributes in TP105 v3 but not in TP414.

Matching Variables ISL

You can determine the variables ISL sampling plan that matches the producer's point and consumer's point of 
any attribute plan. 

With TP414 tab2 enter the Alpha, Beta, AQL, RQL from two points on the attribute oc curve. TP414 will calculate 
the equivalent variables decision rule -- fixed or sequential.
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Terms and Symbols

Nomenclature

Acceptance Sampling Terms and Symbols used by TP414

SYMBOL NAME

Pa probability of acceptance of a lot.

p' fraction defective/nonconforming.

AQL Acceptable Quality Level.

RQL Rejectable Quality Level.

Alpha risk of rejecting a lot if p'=AQL.

Beta risk of accepting a lot if p'=RQL.

n Sample Size

Exact-n Sample Size before rounding to whole number

N Lot Size

Ac Acceptance Number, Same as C

C Acceptance number, same as Ac

X Measured value.

Xbar Sample Average

AL Lower decision limit for Xbar

AU Upper decision limit for Xbar

ISL Individual Specification Limit

LISL Lower Individual Specification Limit

UISL Upper Individual Specification Limit

CL Confidence Limit

LCL Lower Confidence Limit

UCL Upper Confidence Limit

SPR Sequential Probability Ratio

TSS Truncatable Single Sample
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Assumptions and Limitations

Range of Input variables
AQL, RQL: 0.000001 to 0.999999 (decimal fractions)
RQLML, AQLML, AQLMU, RQLMU: -1000000 to 1000000

AL, AU -1000000 to 1000000
Alpha, Beta: 0.000001 to 0.999999 (decimal fractions)

Sample size, n: 1 to 1000000

Normal Distribution
For ISL plans, TP414 uses the normal distribution of the population lot. 

Mean plans are not sensitive to normality because of the central limit theorem.

Getting Help

Context sensitive help:  help F1

Sampling plan help: www.samplingplans.com

Discussion community: (Closed, but it contains much information)
www.samplingplans.com/forum/

Discussion community: (current)
www.samplingplans.com/forum2/

How to activate this program's license:

Your license is probably already activated. 
TP414 will startup by presenting a form with drop-down menus -- much like a word processor would. All of 
the menus will work except for the possible exception of the [Design] menu. 

If the [Design] menu does not open then you need to obtain a license from H & H Servicco Corp.

If you have purchased the program you need to obtain a permanent license. 

If you have a beta version or a trial version then you need to obtain a time-limited license.

In either case, you must send us an "Installation Code". Then we will send you a "Liberation Key" to activate 
the license.
 

The procedure to activate a license is as follows:

STEP 1 of 2 - Send us an "Installation Code":

1) Use menu: [Help][Manage your license]

2) Enter your name.   As you type your name, an "Installation Code" will display in the textbox 
below your name. 

3) Copy the "Installation Code" to the Windows clipboard. 

4) Push the [Close] button to close the form.
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5) Use menu: [Help][Internet][Email - to samplingplans.com]
This will start your email program.

6) Paste the "Installation Code" into the message area of the email. 

7) Add the title "Send Liberation Key" and add any appropriate message.

8) Send the email to support@samplingplans.com.

STEP 2 of 2 - We send you a "Liberation Key" to activate the license.

9) You will receive back a "Liberation Key". We prepare the liberation key manually, so if you are 
in a hurry, phone us at 651-777-0152 to expedite the service.

10) Copy the liberation key from our email to the Windows clipboard. 

11) Use menu [Help][Manage your license] and paste the "Liberation Key" into the textbox labeled 
"Liberation Key".

12) Push the [Register] button. 

You can now use the [Design] menu to access all of the program's sampling plan design capabilities.

NOTE 1 - If you want to use the program both at work and at home, you may use the same liberation key to 
activate the program on both computers.  You name will always be on the program in [Help] [About]

NOTE 2 - If you want to use an alternative method of obtaining/registering a license, please contact us. 
651-777-0152

How to Contact H & H Servicco Corp.

Website: www.samplingplans.com

Discussion forum: www.samplingplans.com/forum2/

E-mail service@samplingplans.com

Phone: 651-777-0152

Fax 651-777-0152

Mail: PO Box 9340
North St Paul, MN 55109-0340
USA

Author of TP414: Stan Hilliard
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Attributions: 

TP414 uses the following products:

VB Helpwriter - Teletech Systems
To design this Help system.

ActiveLock
To design the digital signature based copy authentication system

Visual Basic V6 - Microsoft
To design and compile the program code.

Glossary

Ac
With Variables plans the Acceptance Limit is the decision limit for Xbar. Related symbols are k, AL, AU.

With attribute plans, the Acceptance Number is the maximum allowable number of defective items in the sample 
and still accept the lot. The symbols "Ac" and "C" are commonly used to represent the acceptance number.

acceptance limit
An acceptance limit is the decision limit to compare to the sample average. See k, AL, AU

acceptance number
For attribute plans, the acceptance number, symbol=Ac, or C, is the maximum allowable number of defectives in 
the sample for a lot to be accepted. For the acceptance number of zero, the lot is rejected when a sample 
contains one or more defective items.

For variables plans, the corresponding terms are acceptance limit and decision limit.

acceptance sampling
Acceptance sampling has as its purpose to decide whether to accept or reject a population based on the results 
of the inspection of samples taken from that population.

In manufacturing applications of acceptance sampling, the population is typically incoming raw material lots, in-
process sublots, and finished product lots. Other areas involve administrative processes, inventory, etc.

activate
If you have purchased the program your permanent license is probably already activated. 

If you have a beta version or a trial version then you need to activate a time-limited license.

In either case, you must send us (H & H Servicco Corp) an "Installation Code". Then we will send you a 
"Liberation Key" that activates the license.

To activate a license:
Menu: [Help] [Manage Your License]

For see detailed instructions in activating a license for this program:
[Help] [Program Help] [Contents] [License Management]   LicenseManagement.txt

AFI
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AFI (Average Fraction Inspected) is the fraction of items out of a series of lots that will be inspected by the plan. 

For non-rectifying fixed-n plans, AFI = n / N

For non-rectifying sequential plans, AFI = ASN / N

Plans that rectify rejected lots can make AFI increase as p' increases because of 100% inspection of rejected 
lots.

AL
AL is the lower decision limit for the sample average Xbar for Variables plans with known SD. Related symbols 
are k, AU.

Alpha
The Producer's Risk, Alpha, is the risk of rejecting a good lot, that is, a lot that contains AQL fraction 
defective/nonconforming.

ANSI/ASQ Z1.4
This is the current AQL based standard -- "Sampling Procedures and Tables for Inspection by Attributes".

ANSI/ASQ Z1.9
This is the current AQL based standard -- "Sampling Procedures and Tables for Inspection by Variables for 
Percent Nonconforming".

AOQ
AOQ is the Average Outgoing Quality -- the average fraction defective/nonconforming of lots outgoing to 
customers. Useful to evaluate sampling plan applications that rectify rejected lots. The AOQ-Curve is the AOQ 
as a function of various fixed values of p'.

AOQL
AOQL (Average Outgoing Quality Limit) is the maximum AOQ over all possible values of incoming product 
quality (p'), for a given acceptance sampling plan.

AQL
The Acceptable Quality Level, AQL, is the fraction defective/nonconforming of a lot that would have a high 
probability of acceptance. AQL is often (but not necessarily) associated with 0.95 probability of acceptance ( Pa). 
AQL and Alpha define the Producer's Point.

AQLML
Values that you specify when designing a sampling plan for the mean:

RQLML is the lower rejectable level of the mean corresponding to beta.
AQLML is the lowest acceptable level of the true mean, risk=alpha.
AQLMU is the highest acceptable level of the true mean, risk=alpha 
RQLMU is the upper rejectable level of the true mean, risk=beta.

AQLMU
Values that you specify when designing a sampling plan for the mean:

RQLML is the lower rejectable level of the mean corresponding to beta.
AQLML is the lowest acceptable level of the true mean, risk=alpha.
AQLMU is the highest acceptable level of the true mean, risk=alpha 
RQLMU is the upper rejectable level of the true mean, risk=beta.
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ARL
The ARL (Average Run Length) is the average number of lots that will be accepted between until a rejection 
occurs.

The ARL curve of a sampling plan tells you -- for any lot quality, p' -- the average number of lots accepted until 
there is a rejection.

ASN
ASN (Average Sample Number) is the average number of sample units inspected per lot in reaching decisions to 
accept or reject. The ASN curve is a plot of ASN versus true lot quality, p' or mean.

attribute data
Attribute data is go/no-go data like defective/nondefective, broken/whole etc.

Attribute data is to be distinguished from variables data -- which is in the form of numerical measurements.

AU
AU is the lower decision limit for the sample average Xbar for Variables plans with known SD. Related symbols 
are k, AL.

Beta
The Consumer's Risk, Beta, is the risk of accepting a rejectable lot, that is, a lot that contains RQL fraction 
defective. A typical value for the Beta risk is 0.05.

beta version
A beta version of a computer program is for testing of some feature and has a timed license.

C=0
A C=0 attribute sampling plan is one in which the lot is only accepted if zero defectives occur in the sample.

CL
CL is a symbol for "confidence limits". The symbols for the lower and upper confidence limits are LCL and UCL.

confidence limits
Confidence limits define an interval estimate of a variable. The limits LCL and UCL are symmetrical about the 
sample average, Xbar. Xbar is the best point estimate of the mean of the variable. Values outside the confidence 
interval are not plausible. 

The confidence coefficient CC is the percent confidence is 95%. Higher percent confidence produces wider 
intervals. Lower percent confidence produces more narrow intervals.

consumer's point
The Consumer's Point is the point on the oc curve defined by RQL on the X-axis and Beta on the Y-axis. 
Example: beta=0.05 probability of accepting a lot if its fraction defective is RQL=0.10. (10%)

Cpk
Cpk is a quality index.

Cpk = (UISL- Xbar)/(3* SD) or (Xbar - LISL)/(3 * SD), whichever is smaller.

decision limit
A decision limit is compared to the sample average for the accept/reject decision. See k, AL, AU

File: TP414Manual01.doc H & H Servicco Corp. Printed: 01/29/08 Page: 34



TP414 User Manual Sample Planner for Variables SamplingPlans.com

discriminating
The ability of a sampling plan to discriminate (tell the difference) between an AQL lot and RQL lot. A sampling 
plan can discriminate well when its AQL and RQL are sufficiently close together. If one sampling plan is more 
discriminating than another, its oc curve is steeper (more verticle).

exact-n
The exact sample size shows the value of n -- before rounding to a whole number -- that exactly satisfies the 
consumer's point that you entered. The exact n can be useful to know when the sample size is small and the 
direction of rounding can have economic consequences.

False negatives
A false negative is an inspected item which is defective but is incorrectly classified as a good item due to 
inspection error.

The symbol b represents the probability of making such a wrong classification. -- calling a defective "good".

False positives
A false positive is an inspected item which is of good quality but is incorrectly classified as a defective due to 
inspection error.

The symbol a represents the probability of making such a wrong classification. -- calling a "good" item defective.

fixed-n
A fixed-n sampling plan has a decision rule that specifies the same sample size, n, for each lot. This differs from 
a sequential decision rule, for which the sample size varies from lot to lot depending on lot quality, p', and 
random variation..

fraction nonconforming
Fraction nonconforming refers to the fraction of items have measured values below LISL or above UISL or both.

Inspection Error
With attribute data, inspection error is the misclassification of individual items -- "good" items as defective and 
defective items as "good".

The error of misclassification of items is similar to the error of mis-dispositioning lots:

Similarities:

Whereas "alpha" is the probability of rejecting an AQL lot, "a" is the probability of classifying a good item as 
defective.

Whereas "beta" is the probability of accepting an RQL lot, "b" is the probability of classifying a defective as a 
good item.

ISL
ISL is an acronym for Individual Specification Limit. ISL defines when a measured individual item is defective on 
the high side (UISL), the low side (LISL), of both.

With measured data, ISLs are used to calculate the a variables sampling plan's decision rules, calculate Cpk, 
and with rectification plans, to sort nonconforming units from rejected lots.

ISLs
ISL is an acronym for Individual Specification Limit. ISL defines when a measured individual item is defective on 
the high side (UISL), the low side (LISL), of both.

With measured data, ISLs are used to calculate a variables sampling plan's decision rules, calculate Cpk, and 
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with rectification plans, to sort nonconforming units from rejected lots.

ISO 8422
International Organization for Standardization, 8422 -- "Sequential sampling plans for inspection by attributes"

ISO 8423
International Organization for Standardization, 8423 -- "Sequential sampling plans for inspection by variables"

k
The k-value is a decision limit used in variables ISL sampling plans to make the accept/reject decision. k is the 
number of SD s between the average of a sample and the nearest ISL. k is related to Cpk by the relationship 
Cpk=k/3.

k-value
The k-value is a decision limit used in variables ISL sampling plans to make the accept/reject decision. k is the 
number of SD s between the average of a sample and the nearest ISL. k is related to Cpk by the relationship 
Cpk=k/3.

Known SD
Variables sampling plans have a "known SD" when the standard deviation is known in advance and has been 
determined to be in statistical control from lot to lot. This as concluded from using an S Chart. Past in-control 
conditions cannot demonstrate that the current lot has not changed. Therefore good practice is to test the current 
lot SD with a statistical F-test, or for small samples, a statistical range test. With the SD Known procedure the 
sample size is smaller than with the SD Unknown procedure.

license
TP105 uses a licensing system based on RSA public key encryption and digital signatures. 

See the current license status of this program with the menu: 
[Help] [About]

To change the status of the current license or to activate a new license for this program:
[Help] [Manage your License]

LISL
A lower specification limit, LISL, applies to measurements of individual items and defines whether or not that 
individual is in conformance.

Mil-Std-105
Military Standard 105E -- "Sampling Procedures and Tables for Inspection by Attributes". This standard is based 
on AQL. Now out of print, it replaced by ANSI/ASQ Z1.4.

Mil-Std-414
Military Standard 414 -- "Sampling Procedures and Tables for Inspection by Attributes". This standard is based 
on AQL. Now out of print, it replaced by ANSI/ASQ Z1.9.

n
n:  Lower case n is the symbol for the sample size to be inspected. 

N: Upper case N is the symbol for the lot size (Number of items in the lot.)

nonconforming
An individual measured item is nonconforming to specification when its measurement is below LISL or above 
UISL.

ntable
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The ntable organizes an attribute sequential decision rule into four columns. 

 (1)               (2)           (3)               (4)
Sample Size (n)        Accept        Reject
From            To        on   Ac        on Re

OC
The oc curve (Operating Characteristic Curve) of a sampling plan is a graph of Pa versus p',  where Pa = 
probability of acceptance, p' = true lot fraction defective of a lot. The oc curve tells you how the sampling plan will 
perform in making accept/reject decisions.

oc curve
The oc curve (Operating Characteristic Curve) of a sampling plan is a graph of Pa versus p',  where Pa = 
probability of acceptance, p' = true lot fraction defective of a lot. The oc curve tells you how the sampling plan will 
perform in making accept/reject decisions.

p'
p' is the symbol for the (true) fraction of items in a lot that are defective.

p'L
p'L is a symbol for the lower confidence limit.

p'U
p'U is a symbol for the upper confidence limit.

Pa
Pa is the probability that a sampling plan will accept a lot. Pa depends on the decision rule  (n, C) and the lot's 
fraction defective. ( p').

Pbar
Pbar is a symbol for the sample fraction defective.

population
The population is the decision-unit from which samples are taken for inspection.

In manufacturing applications of acceptance sampling, the population is typically incoming raw material lots, in-
process sublots, and finished product lots.

probability statement
The probability of a type II error:
The probability of accepting a lot if it contains RQL fraction defective 

The probability of a type I error:
The probability of rejecting a lot if it contains AQL fraction defective.

producer's point
AQL and Alpha define the producers point of the OC Curve.

rectification
To rectify a rejected lot is to sort 100% and replace/rework the defective items with good ones.

Rectify
To rectify a lot is to sort it 100% and fix or replace all defectives. A "rectification plan" specifies that all lots that 
the sampling plan rejects be rectified.
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register
See the topic "License Management"  in the menu [Help] [Program Help] [Contents]

RQL
The Rejectable Quality Level, RQL, is the fraction defective of a lot that would have a low probability of 
acceptance. RQL and Beta define the consumer's Point of the oc curve.

Other names that have the identical meaning as RQL are LQ and LTPD.

RQLML
Values that you specify when designing a sampling plan for the mean:

RQLML is the lower rejectable level of the mean corresponding to beta.
AQLML is the lowest acceptable level of the true mean, risk=alpha.
AQLMU is the highest acceptable level of the true mean, risk=alpha 
RQLMU is the upper rejectable level of the true mean, risk=beta.

RQLMU
Values that you specify when designing a sampling plan for the mean:

RQLML is the lower rejectable level of the mean corresponding to beta.
AQLML is the lowest acceptable level of the true mean, risk=alpha.
AQLMU is the highest acceptable level of the true mean, risk=alpha 
RQLMU is the upper rejectable level of the true mean, risk=beta.

sample size
The sample size is number of items drawn from the lot for inspection. The symbol for sample size is n, whereas 
the symbol for the lot size is N.

SD
SD and Sigma are both used as symbols for the Standard Deviation.

SD Known
Variables sampling plans have a "known SD" when the standard deviation is known in advance and has been 
determined to be in statistical control from lot to lot. This as concluded from using an S Chart. Past in-control 
conditions cannot demonstrate that the current lot has not changed. Therefore good practice is to test the current 
lot SD with a statistical F-test, or for small samples, a statistical range test. With the SD Known procedure the 
sample size is smaller than with the SD Unknown procedure.

SD Unknown
Variables sampling plans have an "unknown SD" when the standard deviation is not known prior to taking the 
sample. An estimate of the SD is then calculated from the sample and used in the accept/reject decision. These 
plans do not require that lots be in statistical control. With the SD Unknown procedure the sample size is larger 
than with the SD Known procedure.

sequential
A sequential sampling plan is a technique by which we build up our sample one item at a time, and after 
inspecting each item, ask ourselves: "Can we be sure enough to accept or reject this batch on the information so 
far collected?" 
Its value is in enabling reliable conclusions to be wrung from a minimum of data. This was deemed sufficient to 
require that it be classified "Restricted " within the meaning of the Espionage Act during the war of 1939-45.

sigma
Sigma and SD are both used as symbols for the Standard Deviation.
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TP105
TP105 is the short name of this software program:  "Sample Planner for Attributes"

TP105 allows input of both consumer's point and producer's point, or (n, Ac) to calculate the Alpha and Beta risk, 
or to calculate AQL and RQL. 

TP105 also calculates, in addition to the complete OC curve, the AOQ, ARL, ASN, and AFI curves.

TP105 also calculates, for any (n,Ac),  the matched sequential sampling plan. Or, from two points on the oc 
curve, both fixed-n and sequential sampling plans.

TP414
TP414 is the short name of this software program:  "Sample Planner for Variables"

TP414 designs sampling plans for variables data based on requirements for fraction nonconforming to ISL or on 
requirements for the mean.

TP414 allows input of both consumer's point and producer's point, or (n, AL, AU) to calculate the  Alpha and 
Beta risk, or to calculate AQL and RQL. 

TP414 also calculates, in addition to the complete OC curve, the AOQ, ARL, ASN, and AFI curves.

TP414 also calculates, for any fixed-n plan, the matched sequential sampling plan.

trial version
A trial version of the program is a means for a potential user to evaluate its suitability for his/her application. A 
trial version is a full version but has a timed license.

UISL
An upper specification limit, UISL, applies to measurements of individual items and defines whether or not that 
individual is in conformance.

Unknown SD
Variables sampling plans have an "unknown SD" when the standard deviation is not known prior to taking the 
sample. An estimate of the SD is then calculated from the sample and used in the accept/reject decision. These 
plans do not require that lots be in statistical control. With the SD Unknown procedure the sample size is larger 
than with the SD Known procedure.

variables data
Variables data is numerical data, as opposed to attribute go/no-go data.

variables ISL sampling plan
A variables sampling plan uses a decision rule calculated from numerical measurements of items in a sample. 

An ISL variables sampling plan has specifications that define the conformance of the individual items.

X
Variables data: X represents an individual measurement.

Attribute data: X represents the number of defectives in a sample. You would reject a lot if X is greater than Ac, 
and accept the lot if X is equal to or less than Ac.

Xbar
Xbar is the symbol used for the average of the measurements from a sample.
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Xtable
The Xtable organizes an attribute sequential decision rule into three columns.

Number of       Reject if     Accept if
Defectives      n <= Rn     n >= An

[Design] menu
The [Design] menu opens the window where you to design sampling plans.
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